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Introduction

The Tricent Mk III is a software synthesizer plug-in for Microsoft Windows (VST2/VST3) and Apple macOS
(VST2/VST3/AU) simulating the classic KORG® Trident Mk II from 1982. It is written in native C++ code for high
performance and low CPU consumption. The main features are:

Synthesizer, Brass, and Strings sections

8 or 64 voice polyphony

Flanger effect

Individual stereo outputs for the three sections

Tweaks…

Double precision audio processing

MTS-ESP (https://oddsound.com/) dynamic micro-tuning support

All parameters can be controlled by MIDI controllers

Plug-in supports Windows and macOS (32 bit and 64 bit)

Tricent Mk III is based on the new iPlug2 framework maintained by Oli Larkin and the iPlug2 team. Big thanks,
guys!!! Without your work, it would not have been possible to create a resizable Tricent Mk III user interface.
To resize the plug-in you just grab the yellow triangle at the bottom right of the Tricent Mk III window and drag it.
You can save the current window size using the menu entry “Save Window Size” in the Options Menu.
If you have trouble with the standard version of Tricent Mk III, please grab the (sound-wise identical) “N” version of

https://oddsound.com/


the plug-in which is based on the original iPlug framework.

The KORG Trident mk I & mk II

In 1980 and after the PS-3X00 polyphonic synthesizer series, KORG released the Trident: An eight-voice
programmable polyphonic synthesizer in the fashion of other successful machines such as Sequential Circuits’
Prophet and Oberheim’s OB-X(a). But while the latter offered a pretty sophisticated architecture with Sync and
Cross-Mod options, the Trident synthesizer engine was reduced to almost the absolute minimum. Instead, KORG
added two additional (non-programmable) Brass and Strings sections which lifted the Trident into the league of
classic multi keyboards as known from Farfisa, Crumar, and the like. Obviously the Trident’s subtitle “Performing
Keyboard” was chosen to designate the target audience: Live performing artists with the need for a large variety
of sounds in a single box.
Two years later came the Trident Mk II with some improvements (e.g. two dedicated envelope generators for VCF
and VCA, program recall from memory, etc.) and a light facelift (most notably the black knob caps of the MS/PS
series were replaced by the modern ones as known from the Polysix and the Mono/Poly). But the Trident never
reached the same status as its “brothers” (errr, well…) Jupiter 8, Prophet 5, OB-Xa, and the like. Its sound was
said to be “thin” and  “cheesy” ‒ which is (at least in my opinion) not true. Furthermore, its hardware was believed
to be rather unreliable: Well, that’s a problem with almost all analog gear (ask the owners of a Polymoog) and one
of the good reasons why industry switched over to digital technology.

The Tricent MK III

Many folks asked me to create a VST/AU recreation of the Trident but I was reluctant.
Anyway, you know how things go, I checked the Trident’s schematics, well, not bad, nice ideas, wow, these KORG
engineers were cool, let’s check some videos, okay, done. And since the so-called “Tricent” would become an “MK
III” I added the following features which hopefully are nice to have:

Stereo: All parts can be panned individually.

Additional outputs: Each part can be routed to its individual output.

8 or 64 voice polyphony: Maybe eight voices are a bit tight these days…

 (De-)Tuning capabilities for the Brass and Strings sections.

Stereo Ensemble: Makes the Strings section shine.

Stereo Flanger: Funky.

Not to forget: 64 presets and MIDI CC support!
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Architecture

Because hardware is expensive, the Synthesizer, Brass, and Strings sections of the Trident were based on the
same set of oscillators (one per voice, each one generating a 16’, 8’, and 4’ Sawtooth simultaneously). These
signals are fed into the three sections and processed accordingly (in the Synthesizer section, the signals drive
VCO 1).

Note that while the Synthesizer section is truly polyphonic (one VCO 1, VCO 2, VCF, and VCA per voice), the



Brass section is paraphonic: There is only one VCF and one VCA for all voices.

The Sections

Although the Trident (and the Trident plug-in) is not a very complicated machine I’d like to take some time
explaining the various sections of it and its peculiarities.

Synthesizer Section

The Synthesizer section is pretty basic: The signals of two VCOs (Voltage Controlled Oscillators) are mixed and
processed by a standard 24dB lowpass filter (VCF; Voltage Controlled Filter) following a standard VCA (Voltage
Controlled Amplifier). Of course the term “voltage controlled” has to be taken with a grain of salt – there is no

“control voltage” inside the software plug-in. 

VCO 1 offers three waveforms: Sawtooth, Pulse Width, and Pulse Width Modulation, where the latter is
modulated by a dedicated LFO (Low-Frequency Oscillator). VCO 2 only produces a Sawtooth wave and can
optionally be turned off.
The VCF has its own envelope generator (EG) and allows for self-oscillation. Keyboard tracking is available in five
steps (off, 25%, 50%, 100%, 150%).
Besides an Attenuator control, the VCA features the mystical Auto Damp function (which is known from the
Mono/Poly, too). Since the Trident does not offer a  Unison mode, playing solo lines on the polyphonic synthesizer
may result in unwanted “tails” of previously played notes. With Auto Damp switched on, these “tails” are cut. Try it
for yourself, this feature is hard to explain in words… The volume of the whole section is set by the Volume knob.
Furthermore, the section can be completely turned on or off using the Output switch.

Brass Section

The Brass section is even more simplistic: Here, the 16’ and/or 8’ Sawtooth signals are run through a single VCF
and a single VCA controlled by a single envelope generator (EG). This means that the whole section is
paraphonic.
However, there are some cool extras: You can control whether the EG should be triggered for each key
(“Multi[ple]”) or only for the first one played, but you can also select how many keys have to be pressed (2, 4, 6 or
8) before the EG starts. This function is activated by the Select button.



Strings Section

Some folks say that the Strings are the heart of the Trident. The 16’, 8’ and 4’ Sawtooth signals can be activated
individually and are sent through a (polyphonic)
VCA section with a simple Attach/Release envelope. After that, the Strings signal is processed by an equalizer
followed by a delayed Vibrato and an Ensemble effect.
Note that the Strings Vibrato is realized by a bucket brigade device (as known from vintage stompboxes) and not
by modulating the signal generators themselves! Furthermore, note that the Vibrato and Ensemble effects are
turned off if the respective button is lit.

An interesting addition is a Bowing effect: The intend here obviously is to simulate the characteristics of bowing
the strings. Hmm, I tend to call it the  “Something” effect.
Finally, the key Zyboard balance of the built-in Filter effect controls the “sharpness” or “dullness” of the string
sound with respect to the played note.



Flanger Effect

In the early 80s, it was already pretty common for synthesizers to be equipped with a Chorus effect. However, the
KORG designers decided to add a Flanger to the Trident (unique selling point?).
This characteristic effect is capable of self-oscillation and can be activated individually for the three sections. Many
artists were heavily using it as an additional source for experimental sound shaping.

Delay Vibrato and Wheels Section

There is a global delayed Vibrato effect that directly modulates the signal generators (as opposed to the Strings
Vibrato) and thus affects all three sections  (Synthesizer, Brass, and Strings) at the same time. The vibrato delay
can be switched on or off but its delay time is fixed (well almost; see section Tweaks and Output Section). The
speed of the Vibrato effect is controlled just below in the Wheels section.

The original Trident featured a joystick instead of the well-known Pitchbend and Modulation wheels: The
horizontal axis was used for pitch bending while moving the joystick “up” controlled the intensity of the Vibrato
effect and moving the joystick down introduced a “trill effect” – basically a vibrato with a  rectangular waveform.



Since today’s MIDI controllers typically are equipped with wheels instead of joysticks I decided to “map” the
joystick functionality here. Thus you can select whether the Modulation wheel controls a standard Vibrato or the
“trill” effect. Furthermore, you can set the range for the Pitchbend wheel.

Key Assign Section

The Trident/Tricent features two modes for assigning the eight voices. In mode 1 the engine tries to assign any
new note to a new voice so that the other voices are not cut off (if possible).
Mode 2 is suitable for solo play because here the engine will assign the next note to the same voice as before if
only one note is played at a time. This prevents potential “mudding” of the sound for long release times (also see
Auto Damp in the Synthesizer section).

It was not a good idea to switch the mode while playing the Trident – this caused a weird pitch drop of the played
voices to the lowest note. On the Trident plug-in, it will cause all notes to be stopped. You may also note a slight
itching at the back of your head (just kidding).
Besides a global tuning knob, the three sections can be split across the keyboard.
While the Trident had a fixed split point between the second and third octave of the keyboard, the Tricent plug-in
provides a variable split point.

Tweaks and Output Section

Here come the things that make the “Mk III”-part of the Tricent plug-in – the tweaks. First of all, you can change
from the original eight to sixty-four voices of polyphony. This really makes a big difference when playing pads,
arpeggios, etc.



Second, you can switch the Flanger and/or the Strings Ensemble effects to stereo mode (the original Trident was
an “all mono machine”). Space – the final frontier.

Next, you can detune the Brass and the Strings sections individually. Remembering what was said in section
Architecture, this means that both Brass and Strings will have their own additional set of signal generators, and
this is exactly what happens when you turn one of the Detune knobs (LED is on). Be aware that this will increase
the CPU load of your computer!

There are some more parameters that are not accessible from the front plate (you can adjust them using the
plugin parameter control of your DAW): Ensemble
speed and modulation amount as well as Delayed Vibrato delay time.
Finally, the Tricent offers a dedicated Output section where you can adjust the stereo panorama and the response
to velocity for each of the three sections (note
that the original Trident did not react to velocity). The EGto-VCF amount of the Synthesizer and the Brass
sections can be controlled by velocity, too. And
there is a Total Volume knob.

Control Operation



Control Section
To select one of the 64 patches just click on the program number or the previous/next arrow buttons, and edit its
name by clicking in the text field.

MIDI Learn And The Config File “tricent.ini”
Every parameter of the Trident can be controlled by one MIDI controller. If you want to change the assignment of
MIDI controller (CC; MIDI Control  Change) to Trident parameter the MIDI Learn function comes in quite handy:
Just click the MIDI button at the Control section (button turns yellow) and wiggle both the MIDI controller and the
parameter you want to assign (you can abort LEARN by clicking the button again). If you want to unlearn the
assignment, right-click the MIDI Learn button (the label now reads “UNLEARN”). Now wiggle the MIDI controller or
the parameter that you want to
unlearn. To save the controller assignments use “Save Configuration” in the Options menu (see next section);
they are stored in the tricent.ini configuration file. The exact location of this file depends on your operating system
and will be displayed when you click on “Reload” or “Save Configuration”.

Options Menu
When clicking on the Menu button, a context menu opens with the following options:



Copy Program Copy the current program to the internal clipboard

Paste Program Paste internal clipboard to a current program

Init Program Initialize the current program

Load Program Load a program file containing a patch to the Trident’s current program

Save Program Save the Trident’s current program to a program file

Load Bank Load a bank file containing 64 patches into the Trident

Save Bank Save Tricent’s 64 patches to a bank file

Select Startup Bank Select the bank file that should always be loaded when the Trident is started

Load Startup Bank Load the Startup bank file; can also be used to check what the current Startup
bank is

Unselect Startup Bank Unselect the current Startup bank

Show Voice Schedule A leftover from development which I forgot to remove

MIDI Thru Set globally if MIDI data sent to the Trident should be sent through to its MIDI 
output (stored in the configuration file)

Ignore Program Change Set globally if MIDI Program Change data sent to the Trident should be ignore
d (stored in the configuration file)

Reload Configuration Reload the Trident’s configuration file

Save Configuration Save Tricent’s configuration file

Check Online for Update When connected to the Internet, this function will check if
a newer version of the Trident is available at fullbucket.de

Visit fullbucket.de Open fullbucket.de in your standard browser

Parameters

Key Assign

parameter ID value / notes

Trident Mode 0 Off / On [64 / 8 voices polyphony]

Key Assign 1 Mode 1 or 2

Total Tune 2 ± 100 cent

Range Synthe 3 Lower, Both, Upper

Range Brass 4 Lower, Both, Upper

Range Strings 5 Lower, Both, Upper

Split Key 6 C-2 – G8

Synthesizer



parameter ID value / notes

VCO 1 Octave 7 16’, 8’, 4’

VCO 1 PW/PWM 8 0 – 100%

VCO 1 PWM Speed 9 0.001 – 25Hz

VCO 1 Wave 10 Sawtooth, Pulse Width, PW Modulation

VCO 2 Octave 11 Off, 16’, 8’, 4’

VCO 2 Detune 12 ± 100 cent

VCF Cutoff 13 0 – 100%

VCF Resonance 14 0 – 100%

VCF KBF Track 15 0 – 150%

VCF EG Intensity 16 ± 100%

VCF Attack 17 0 – 100%

VCF Decay 18 0 – 100%

VCF Sustain 19 0 – 100%

VCF Release 20 0 – 100%

VCA Attack 21 0 – 100%

VCA Decay 22 0 – 100%

VCA Sustain 23 0 – 100%

VCA Release 24 0 – 100%

VCA Attenuator 25 ± 10 dB

VCA Auto Damp 26 Off / On

Brass



parameter ID value / notes

Brass Cutoff 27 0 – 100%

Brass Resonance 28 0 – 100%

Brass Silent Notes 29 2, 4, 6, 8

Brass EG Intensity 30 0 – 100%

Brass Attack 31 0 – 100%

Brass Decay 32 0 – 100%

Brass Sustain 33 0 – 100%

Brass Release 34 0 – 100%

Brass 16′ 35 Off / On

Brass 8′ 36 Off / On

Brass Multi Trigger 37 Off / On

Brass Trigger Select 38 Off / On

Strings



parameter ID value / notes

Strings Attack 39 0 – 100%

Strings Release 40 0 – 100%

Strings EQ High 41 ± 12 dB

Strings EQ Low 42 ± 12 dB

Strings Bowing Level 43 0 – 100%

Strings Bowing Tone 44 0 – 100%

Strings Vibrato Delay 45 0 – 100%

Strings Vibrato Speed 46 0.001 – 25Hz

Strings Vibrato Intensity 47 0 – 100%

Strings KBD Balance 48 0 – 100%

Strings 16′ 49 Off / On

Strings 8′ 50 Off / On

Strings 4′ 51 Off / On

Strings Bowing 52 Off / On

Strings Vibrato 53 On / Off

Strings Ensemble 54 On / Off

Delay Vibrato and Wheels



parameter ID value / notes

Vib. Intensity 55 0 – 100%

Vib. Delay 56 Off / On

Vib. Delay Time 57 0 – 100% (hidden parameter!)

Wheel Vib. Intensity 58 0 – 100%

Wheel Vib. Speed 59 0.001 – 25Hz

Wheel Mode 60 Vibrato / Trill

Pitch Bend 61 ± 1200 cent

Flanger

parameter ID value / notes

Flanger Speed 62 0.001 – 25Hz

Flanger Feedback 63 0 – 100%

Flanger Intensity 64 0 – 100%

Flanger Manual 65 0 – 100%

Flanger Synthe 66 Off / On

Flanger Brass 67 Off / On

Flanger Strings 68 Off / On

Output



parameter ID value / notes

Total Volume 69 -∞ – 0 dB

Volume Synthe 70 -∞ – 0 dB

Volume Brass 71 -∞ – 0 dB

Volume Strings 72 -∞ – 0 dB

Output Synthe 73 Off / On

Output Brass 74 Off / On

Output Strings 75 Off / On

Pan Synthe 76 ± 100%

Pan Brass 77 ± 100%

Pan Strings 78 ± 100%

Velocity Synthe 79 0 – 100%

Velocity Brass 80 0 – 100%

Velocity Strings 81 0 – 100%

Velocity Synthe VCF 82 0 – 100%

Velocity Brass VCF 83 0 – 100%

Tweaks



parameter ID value / notes

Stereo Flanger 84 Off / On

Stereo Ensemble 85 Off / On

Detune Brass 86 ± 700 cent

Detune Strings 87 ± 700 cent

Ens. LFO1 Speed 88 0.001 – 25Hz (hidden parameter!)

Ens. LFO2 Speed 89 0.001 – 25Hz (hidden parameter!)

Ens.1 Amount 90 0 – 100% (hidden parameter!)

Ens.2 Amount 91 0 – 100% (hidden parameter!)

Ens.3 Amount 92 0 – 100% (hidden parameter!)

Frequently Asked Questions
How do I install the Tricent (Windows VST2 32 bit version)?
Just copy the files tricent.dll from the ZIP archive you have downloaded to your system’s or favorite DAW’s VST2
plug-in folder. Your DAW should automatically register the Tricent VST2 plug-in the next time you start it.
How do I install the Tricent (Windows VST2 64 bit version)?
Just copy the file tricent64.dll from the ZIP archive you have downloaded to your system’s or favorite DAW’s VST2
plug-in folder. Your DAW should automatically register the Tricent VST2 plug-in the next time you start it.
Note: You may have to remove an existing (32 bit) tricent.dll from your VST2 plug-in folder or else your DAW may
screw the versions up…
How do I install the Tricent (Windows VST3 64 bit version)?
Just copy the files trident.vst3 from the ZIP archive you have downloaded to your system’s or favorite DAW’s VST3
plug-in folder. Your DAW should automatically register the Tricent VST3 plug-in the next time you start it.
How do I install the Tricent (Mac VST2/VST3/AU 64 bit)?
Locate the downloaded PKG package file tricent_1_1_0_mac.pkg in Finder (!) and do a right- or control-click on it.
In the context menu, click on “Open”. You will be asked if you really want to install the package because it comes

from an “unidentified developer” (me ). Click “OK” and follow the installation instructions.
What is the plug-in ID of the Tricent?
The ID is T r i 3.
How do I know if a new version of the Tricent is available?
When connected to the Internet, open the File menu (see section Options Menu) by clicking the disk icon and
selecting the entry “Check Online for Updates”. If a new version of the Trident is available on fullbucket.de the
respective information will be shown in a message box.
How can I increase the CPU performance?

Switch from 64 to 8 voices polyphony.

Undo detuning of the Brass and Strings sections.

Turn off (orange buttons!) any section that is not needed.

Documents / Resources
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